
 
 

 

 

  

 

 

 

 

 

Office 365 
Quick Start User Guide



 

 
MONROE PUBLIC SCHOOLS ● TECHNOLOGY ● OFFICE 365 USER GUIDE 

 

 

 

 

  

 

 

 

 

 
  



 

 
MONROE PUBLIC SCHOOLS ● TECHNOLOGY ● OFFICE 365 USER GUIDE 

 

Contents 

 
What is Office 365? ....................................................................................................................................... 5 

How to Sign In to Office 365 ..................................................................................................................... 5 
To Sign Out when you are done ................................................................................................................ 5 
Why Use Office 365? ................................................................................................................................. 5 

Office 365 Home Page .................................................................................................................................. 6 

Top right-hand web navigation ................................................................................................................. 6 
Install Office on more Devices ...................................................................................................................... 7 

On a PC or Mac: Install .............................................................................................................................. 7 
On a Smartphone or an iPad: Setting up mobile apps .............................................................................. 7 

Collaborate with Office Online ..................................................................................................................... 8 

OneDrive for Business ................................................................................................................................... 8 

How to access OneDrive on your PC/Mac ................................................................................................ 8 
How to access OneDrive on your iPad or mobile device .......................................................................... 9 
Once you are logged into OneDrive your screen should look like this: .................................................... 9 

Web Office Apps ......................................................................................................................................... 10 

To make a new document or folder ........................................................................................................ 10 
Naming or Renaming a Document on Office Online ............................................................................... 11 

Sharing ........................................................................................................................................................ 12 

To Share a document .............................................................................................................................. 12 
Sharing a Folder ...................................................................................................................................... 13 
To share a document anonymously ........................................................................................................ 13 
Collaborating on a Document from Word, Excel, etc. ............................................................................ 13 

OneNote ...................................................................................................................................................... 14 

Sites ............................................................................................................................................................. 14 

Newsfeed .................................................................................................................................................... 14 

Saving and Printing your Documents .......................................................................................................... 15 

Saving your documents ........................................................................................................................... 15 
Word: Print from the browser ................................................................................................................ 15 
Excel: Print from the browser ................................................................................................................. 15 
PowerPoint: Print from the browser....................................................................................................... 15 

FAQ’s ........................................................................................................................................................... 16 

Upload files stored on your iPhone or iPad to OneDrive for Business ................................................... 16 
How do I switch between Mobile view and PC view on OneDrive for Business? ................................... 16 
How do I switch between PC view and Mobile view on OneDrive for Business? ................................... 17 
If you cannot log on to Office 365 from your web browser. .................................................................. 18 

 



 

 
MONROE PUBLIC SCHOOLS ● TECHNOLOGY ● OFFICE 365 USER GUIDE 

 

 
 



   P a g e  | 5 

 

 
MONROE PUBLIC SCHOOLS ● TECHNOLOGY ● OFFICE 365 USER GUIDE 

 

What is Office 365? 
 

Office 365 is a Microsoft product offering an online version of the Office Suite. Here’s how it works: 

How to Sign In to Office 365 

You can sign onto Office 365 from any computer located in the district by   

double clicking this shortcut on the computers desktop. 

You can also enter this link https://portal.office.com/Home into the web 

address bar from anywhere. Either way you must enter your full MPS email 

address and password to sign into Office 365. 

 

 

Office 365 sign in screen. 
 

To Sign Out when you are done 

Logout by clicking on down arrow by your username in upper right and selecting Sign Out. 

Why Use Office 365? 

 Office when and where you need it. 

 The best & latest version of Office. 

 All your work in one place.  

Enter your MPS email and 

password to sign into 

Office 365. 

https://portal.office.com/Home
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Office 365 Home Page 
The new home page is not just a place where you can easily access all the services available to you. The 

home page automatically detects the device you’re using, and displays the appropriate install prompt. 

For example, if you’re using a PC, it prompts you to install the applications on your PC, as the image 

below shows. If you’re using a Mac, it prompts you to install Office for Mac. 

 Click the Office 365 logo in the top left-hand web navigation to go to the home page. 

 Install Office on your PC – Installs software onto other devices such as iPad or Smartphone. 

 Collaborate with Office Online - Save documents, spreadsheets, and presentations online, in 

OneDrive. Share them with others and work together at the same time.  

  

Top right-hand web navigation 

 Newsfeed 

 OneDrive 

 Sites 

 Sign-in  

 Settings Menu (Gear) 

 Help 

The Home Page gives you a convenient map of all your services and provides easy navigation and quick 

access to the tools you rely on to get your work done, plus a way to explore new tools and services. 

 

 

Automatically detects 

the device you are 

using, for example, if 

you are using a PC. 

Easily access Web 

Apps that are 

available to you.  
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Install Office on more Devices 
Once you have installed the Office applications, the home page displays all your Office 365 online 

services, providing you with quick access to launch documents and start creating right away. You may 

want to use this new home page as your start page—for consistent and comprehensive access to your 

services. 

On a PC or Mac: Install 

 
 

 

On a Smartphone or an iPad: Setting up mobile apps 

 

 

You can also go to Settings  > Office 365 settings > Software > Phone & tablet.  
 

 

 

  

Click the Settings icon to access drop-down menu 
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Collaborate with Office Online 
Office 365 includes three services that let you share ideas and documents, and collaborate with people 

inside and outside of the district: Sites, OneDrive, and Newsfeed.  

You will also find Office Web Apps that let you create, edit and share your Excel, Word, PowerPoint and 

OneNote files from any browser. You can share and simultaneously work on your documents with 

students, friends and co-workers.  

In this training session we give a brief overview on Sites and Newsfeeds while focusing on OneDrive and 

Web Apps by showing how to create, access, and save your files on your PC/Mac or your mobile devices. 

 

OneDrive for Business 
OneDrive for Business (formerly SkyDrive) is cloud storage for business or educational 

organizations. It is a place where people can organize and store documents and other files. 

All files stored in OneDrive are private by default, however, files can be easily shared with 

others to allow for collaboration. Web Office Apps, such as, Word, PowerPoint, Excel and 

OneNote documents can be created via a web browser. 

OneDrive for Business let you access and share documents, including documents from Word, Excel, 

PowerPoint, OneNote, and Access. Most of the time it will be your starting point unless you are creating 

a new document. 

How to access OneDrive on your PC/Mac 

1. Log onto Office 365 from any computer located in the district by double-clicking the shortcut 

icon on the computers desktop or by the web link https://portal.office.com/Home 

2. Click OneDrive. 

 

 

Click OneDrive at either location 

https://portal.office.com/Home
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How to access OneDrive on your iPad or mobile device 

You can access OneDrive by launching the App or by using the web link https://portal.office.com/Home 

just like you would on any computer.  

On your iPad or mobile device: 

1. Launch the One Drive App by tapping the icon from your iPad or mobile device 

2. Sign into your account by entering your full email address and password 

  

      

  

 

 

 

 

 

If you use the web link OneDrive will look just like you logged on from any computer located in the 

district. If not at the end of this document see: How do I switch between PC view and mobile view on 

SharePoint team sites or OneDrive for Business?  

Once you are logged into OneDrive your screen should look like this: 

      

The OneDrive screen from iPad or mobile web app.         The OneDrive Online screen from web link access 

Note that the web app will not show the same screen as the web link. You will have to tap a document 

first, then the (…) at the lower right, then Launch Web App. The file will open up in Office 365 Online in 

the files program (Word, Excel, etc.). You can tap your name at any time to return to OneDrive Online 

(not the OneDrive Web App) or tap one of the options (Edit, Print, Share, etc.). Changes to your file will 

be automatically saved. 

Tap the OneDrive App Web App Sign on screen 

https://portal.office.com/Home
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Web Office Apps 

          

Web Office Apps, such as, Word, PowerPoint, Excel and OneNote documents can be created via a web 

browser. Just click the app you want to create a new document. 

 

To make a new document or folder 

You can also make a new document by clicking OneDrive at the top of the page then: 

1. Click on New to display the popup menu of Web Apps. 

 

 

 

 

 

2. Click on the type of Document, such as Word, and the Web APP will launch. 

                                
 

Click a Web App to create 

a new document via the 

web browser. 

Click OneDrive. 

Click New. 
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Notice, when the document opens, you have an OPTION to open the document on your PC (not the web 

app), just make sure to save your document to your PC. If using the web app your files will automatically 

be saved in OneDrive. 

 

 

 

 

 

Popup messages might appear. Click yes to open this file on your computer. If the file does not open 

on your computer because requirements are not met, Office 365 gives you the option to return to 

Word Online. 

                  

Naming or Renaming a Document on Office Online 

When you start a new, blank document in Office Online, your doc gets a default name like “Document4” 

or “Presentation2.” To rename the document while you’re editing it, click on the file name near the top 

of the browser window, and type the name you want. 

 

If nothing happens when you type, check to make sure you’re in Editing view (on the View tab, click 

Editing View). You won’t be able to rename a file if other people are working on it at the same time you 

are. Wait until you’re the only one in the doc, and then rename it. 

Click to open Word on your 

PC (not in a web browser). 

Rename the document by clicking on the file 

name near the top of the browser. 

Click your name to return to 

home page of Office 365. 

Click here to name or 

rename a document. 
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Sharing 
Sharing a document from Word, Excel, etc. is very simple and easy.  The document must be opened up 

from within OneDrive and you must be done editing the document.  Click on Share in the upper left side 

and the regular OneDrive sharing box will open.  Proceed to share your document as listed below. 

 

 

 

 

 

 

To Share a document 

1. Highlight the file and click the Share icon at the top. 

2. Click on Invite People and type in the email address of the person you would like to share 

your document. 

 

On this page, there are several things you can select. 

 You can select whether you can Edit or View Only from the upper right drop-down. 

 You can click on Show Options.  This allows you to turn on or off Send Email Message.  The 

default is to send an Email Message to the person you are sharing with.  

 You can also turn off Require sign-in but we do not recommend that you do this.  

 

  

Click here to share a 

document or file 

Click here to share a 

document or file. 
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Sharing a Folder  

This is exactly like sharing a File except that you cannot share an entire Folder without using a valid 

Account.  You will not see Get a Link when you try to share an entire Folder.  

To share a document anonymously  

1. Select Get a Link and can select View Only or Edit.   

Get a Link allows the link to be shared with anyone outside of the district.  This method of sharing will 

allow for anonymous access and people can send this link on to others, so please be cautious about 

sharing documents this way. You can also select Shared With on this same page to see who you have 

shared documents with. 

Collaborating on a Document from Word, Excel, etc.  

This will allow multiple people to work on a document at the same time.  To do this, share the 

document.  If another person is editing the document at the same time, it will show up in the upper 

right hand corner.  

 

  

Displays if another person is 

editing the document. 
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OneNote  

When you’re planning a group activity OneNote Online gives your group a centralized 

place for collecting notes, brainstorming an idea, or assembling the bits into a more 

structured document, such as an itinerary you can share with your contacts as a Word 

document. 

1. Go to where the notebook is stored on your OneDrive. 

2. Click the notebook. OneNote Online opens the notebook in Editing view. 

3. Add notes to the current page, click a different page to edit, or add new pages or sections to the 

notebook in the navigation pane. OneNote Online saves your changes automatically. Your file 

is automatically saved in OneDrive for you. 

4. If you want to make changes beyond what you can do in the browser, click the File tab, and 

then click Edit Notebook, and then Edit in OneNote Online (requires Microsoft OneNote 2010 

or later). 

 

Sites 

A site is a group of related Web pages and apps where your team can work on projects 

and share information. You can create sites where you can collaborate with others, as 

long as you have permissions to create sites. 

To open your sites, click the Sites item on the top of your page. 

At this time Monroe Public Schools does not support training for sites. 

 

 

Newsfeed 

Newsfeed allows you to share ideas by posting to a newsfeed, follow people, 

documents, and tags to keep informed about activities and updates or Blog to share 

information with teachers or classmates. 

To open your newsfeed, click the Newsfeed item on the top of your page. 

 

At this time Monroe Public Schools does not support training for newsfeeds.  
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Saving and Printing your Documents 
Saving your documents 

Office 365 saves your documents and changes automatically. Your files are automatically saved in 

OneDrive for you. 

Word: Print from the browser 

The document that you print from the browser looks the same as it would if you printed it from Word. 

With the document open in Word Online, click the File tab in Word Online, and then click Print, and 

click Print again. A printable PDF is generated. Open it by clicking Click here to view the PDF of your 

document, and then follow the procedure you normally do for opening and printing PDF files from 

your browser. 

Excel: Print from the browser 

1. If you want to print a range of cells instead of the entire worksheet, select the cells. 

2. On the File tab, click Print. 

3. If popups are blocked, unblock them, at least for now. Then repeat steps 1 and 2. 

Excel Online opens a view suitable for printing in a new browser tab or window. 

4. If you selected a range of cells, but you want to print the whole worksheet after all, click Entire 

Sheet. 

5. Click Print. 

PowerPoint: Print from the browser  

You might want to print the slides as handouts to share with the class. Click the File tab, and then click 

Print and click Print again. A printable PDF is generated. Open it by clicking Click here to view the PDF of 

your document, and then follow the procedure you normally do for opening and printing PDF files from 

your browser. 
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FAQ’s 
Upload files stored on your iPhone or iPad to OneDrive for Business 

1. You cannot upload files such as pictures or videos stored in the picture library on your iPhone or 

iPad directly to OneDrive for Business. 

How do I switch between Mobile view and PC view on OneDrive for Business? 

You can view OneDrive for Business in Mobile view or PC view.  

 

Mobile View Screen from your iPad or mobile device 

To switch from Mobile view to PC view 

1. In a site or library, select the More (…) in the lower right corner of the screen. 

2. Select Switch to PC view.  

Tap More (…) to display the 

drop down menu then tap 

switch to pc view. 
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How do I switch between PC view and Mobile view on OneDrive for Business? 

You can view OneDrive for Business in PC view or Mobile view.  

 

 

Pc View from your iPad or mobile device 

To switch from PC view to mobile view: 

If you are in pc view and want to return to mobile view, at the top right of the page: 

1. Select  Settings.  

2. In the drop down menu select Mobile view. 

 

 

  

Tap Settings  to display the 

drop down menu then tap 

switch to mobile view. 

Select switch to mobile view 
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If you cannot log on to Office 365 from your web browser.  

Office 365 is designed to work with the following software: The current or immediately previous 

version of Internet Explorer or Firefox, or the latest version of Chrome or Safari. You can try 

following these first steps.  

 Log on with another browser, such as Safari, Internet Explorer, Firefox. 

 Clear cache and delete cookies. 

1. Click the Chrome menu  on the browser toolbar. 

2. Select More Tools. 

3. Select Clear browsing data. 

4. In the dialog that appears, select the checkboxes for the types of information that 

you want to remove. 

5. Use the menu at the top to select the amount of data that you want to delete. 

Select beginning of time to delete everything. 

6. Click Clear browsing data. 
 

Still having issues?  

For any questions or concerns please contact Support via the web portal or calling 3150. 
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